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ПРЕДИСЛОВИЕ

	Методические указания для студентов по выполнению практических работ адресованы  студентам очной, заочной и заочной с элементами дистанционных технологий формы обучения.
	Методические указания созданы в помощь для работы на занятиях, подготовки к практическим работам, правильного составления отчетов.
	Приступая к выполнению практической работы, необходимо внимательно прочитать цель работы, ознакомиться с требованиями к уровню подготовки в соответствии с федеральными государственными стандартами (ФГОС), краткими теоретическими сведениями, выполнить задания работы, ответить на контрольные вопросы для закрепления теоретического материала и сделать выводы. 
	Отчет о практической работе необходимо выполнить и сдать в срок, установленный преподавателем. 
	Наличие положительной оценки по практическим работам необходимо для допуска к экзамену, поэтому в случае отсутствия студента на уроке по любой причине или получения неудовлетворительной оценки за практическуюнеобходимо найти время для ее выполнения или пересдачи.

Правила выполнения практических работ
	1. Студент должен прийти на практическое занятие подготовленным к выполнению практической работы.
	2. После проведения практической работы студент должен представить отчет о проделанной работе.
	3. Отчет о проделанной работе следует выполнять в журнале практических работ на листах формата А4 с одной стороны листа.

Оценку по практической работе студент получает, если:
- студентом работа выполнена в полном объеме;
- студент может пояснить выполнение любого этапа работы;
- отчет выполнен в соответствии с требованиями к выполнению работы;
- студент отвечает на контрольные вопросы на удовлетворительную оценку и выше.
	Зачет по выполнению практических работ студент получает при условии выполнения всех предусмотренных программой работ после сдачи журнала с отчетами по работам и оценкам.

Внимание!Если в процессе подготовки к практическим работам или при решении задач возникают вопросы, разрешить которые самостоятельно не удается, необходимо обратиться к преподавателю для получения разъяснений или указаний в дни проведения дополнительных занятий. 













Обеспеченность занятия:
1. Учебно-методическая литература:
Основные источники:
1. Вычислительная техника: Учебное пособие / Душкин А.В., Ланкин О.В., Чекризов Р.В. - Воронеж: Воронежский институт ФСИН России, 2015. - 325 с. ISBN 978-5-4446-0731-2.
2. Проектирование аналоговых и цифровых устройств: Учебное пособие / В.С. Титов, В.И. Иванов, М.В. Бобырь. - М.: НИЦ ИНФРА-М, 2014. - 143 с.: 60x88 1/16. - (Высшее образование: Бакалавриат). (обложка) ISBN 978-5-16-009101-3.
3. Микропроцессорные системы: Учебник / В.В. Гуров. - М.: НИЦ ИНФРА-М, 2016. - 336 с.: 60x90 1/16. - (Высшее образование: Бакалавриат) (Переплёт) ISBN 978-5-16-009950-7.
4. Бесперстов,Э.А. Б53 Исследование логических схем с использованием программного комплекса Multisim: лабораторный практикум / Э.А. Бесперстов; Балт.

Дополнительные источники:
1. Основы электроники и цифровой схемотехники: Учебное пособие / Богомолов С.А. – Москва: Издательский центр «Академия», 2016 – 203с.
2. Мышляева И.М. Цифровая схемотехника– М.: Издательский центр «Академия», 2014. – 400 с.
Интернет ресурсы:
1. Электронно-библиотечная система. [Электронный ресурс] – режим доступа: http://znanium.com/ 
2. Википедия – Свободная энциклопедия [Электронный ресурс] – режим доступа: http://ru.wikipedia.org/ 
	Технические средства обучения: 
   	 - компьютер с лицензионным программным обеспечением MULTISIM



Порядок выполнения отчета по практической работе
1. Ознакомиться с теоретическим материалом по практической работе.
2. Записать краткий конспект теоретической части.
3. Выполнить предложенное задание.
4. Продемонстрировать результаты выполнения предложенных заданий преподавателю.
5. Ответить на контрольные вопросы.
6. Записать выводы о проделанной работе.

















Лабораторная работа № 1
«Краткое описание пакета  MULTISIM»

Цель работы: Изучить пакет MULTISIM, исследование логических схем 

Образовательные результаты, заявленные во ФГОС третьего поколения:
Студент должен 
уметь: 
 - строить и использовать таблицы истинности логических функций, элементов устройств;
знать: 
-  типовые узлы и устройства ЭВМ, взаимодействие аппаратного и программного обеспечения ЭВМ

Краткие теоретические и учебно-методические материалы по теме лабораторной  работы
Разработка любого радиоэлектронного устройства  включает физическое или математическое моделирование. Физическое моделирование связано с большими материальными затратами, так как требует изготовление макетов и их трудоемкое исследование. Иногда чисто физическое моделирование просто невозможно из-за сложности устройства. В этом случае прибегают к математическому моделированию с использованием средств и методов вычислительной техники. 
Наиболее простой и  легко осваиваемой программой, содержащей блок логического моделирования цифровых устройств, является программа Electronics Workbench (EWB) канадской компании Interactive Image Technologies. Особенность программы – наличие в ней контрольно-измерительных приборов, по внешнему виду, органам управления и характеристикам максимально приближенных к их промышленным аналогам. Опыт использования программы в лабораторном практикуме по ряду предметов показывает, что для проведения лабораторных работ достаточно двух часов предварительного ознакомления с программой. Ниже приведено краткое описание программы.
Окно программы Multisim 2001 (версия 6.20) (рис. 1) содержит шкалу меню (вторая строка окна): File, Edit, View, Place, Simulate, Transfer, Tools, Options, Help. Дальше описаны некоторые из них.
Меню Simulate содержит команды:
Run – запуск моделирования;
Pause – временный останов моделирования;
Default Instrument Setting – установка по умолчанию режима работы контрольно-измерительных приборов;
Default Simulation Setting –  выбор идеального (при использовании компонентов типа Virtual) или реального режимов работы моделирования;
Instruments – список контрольно-измерительных приборов (линейка этих приборов расположена слева в окне);
Analyses – список команд моделирования.
[image: ОкноMultisim]
Рисунок 1- Окно схемного редактора программы Multisim

Меню Options – (настройка программы), содержит команды:
Preferences – пользовательские настройки (назначение команд описаны ниже);
Modify Title Block – внесение данных в разделы штампа;
Global Restrictions – установка общего пароля; 
Circuit Restrictions – установка атрибутов только Read-only.
Третья строка  окна содержит:
1) восемь мнемонических кнопок общесистемного характера (System);
2) две кнопки, с помощью которых можно увеличить или уменьшить масштаб изображения (Zoom);
3) девять специальных кнопок, дублирующих наиболее часто используемые команды (Design); 
4) выпадающий список использованных в текущей схеме компонентов (In Use List);
5) кнопку, временно приостанавливающую процесс моделирования;
6) переключатель, запускающий и останавливающий процесс моделирования.
Слева в окне расположена вертикальная панель библиотек компонентов (базы данных Component Bars) , справа – вертикальная панель контрольно-измерительных приборов (Instru-ments).
Кнопки можно сделать видимыми или невидимыми, если вызвать команду View>Toolbars и во всплывающем меню установить (или нет) соответствующие флажки: System, Zoom, Design, 
In Use List. Здесь и далее в данном тексте на первом месте указывается меню из строки меню окна редактора схем, на втором месте – команда из выпадающего меню, появляющегося при выборе кнопки конкретного меню.
Панель библиотек компонентов можно сделать видимой или невидимой, если вызвать команду View>Component Bars и во всплывающем меню установить или нет флажок Multisim Database. 
Панель контрольно-измерительных приборов можно сделать видимой или невидимой, если вызвать команду View>Toolbars  и во всплывающем меню установить или нет флажок Instruments.
Панель библиотек компонентов (базы данных Component Bars) содержит: 
· источники (Sources);
· пассивные компоненты и коммутационные устройства (Basic);
· диоды (Diodes);
· транзисторы (Transistors);
· аналоговые микросхемы (Analog);
· цифровые микросхемы TTL серии (TTL);
· цифровые микросхемы КМОП серии (CMOS);
· одиночные цифровые схемы, АЛУ, регистры, счетчики, мультиплексоры, дешифраторы, ОЗУ и т.п. (Misc Digital);
· микросхемы смешанного типа (Mixed);
· индикаторные устройства (Indicators);
· компоненты смешанного типа (Misc (ellaneous));
· аналоговые вычислительные устройства (Controls);
· радиочастотные компоненты (RF);
· электромеханические элементы (Electro_Mechanical).
Панель контрольно-измерительных приборов (Instruments) содержит:
· цифровой мультиметр (Multimeter);
· функциональный генератор (Function Generator);
· измеритель активной мощности и коэффициента мощности (Wattmeter);
· осциллограф (Oscilloscope);
· измеритель АЧХ и ФЧХ (Bode Plotter);
· генератор слова (Word Generator);
· логический анализатор (Logic Analyzer);
· логический преобразователь (Logic Converter);
· измеритель нелинейных искажений в диапазоне частот от 20 до 200000 Гц (Distortion Analyzer);
· спектральный анализатор (Sperctrum Analyzer);
· прибор для анализа электрических цепей в обобщенном виде – в виде четырехполюсников, имеющих два входа и два выхода (четыре полюса) (Network Analyzer).
Последние три прибора недоступны.

Редактор схем
Окно редактора схем предназначено для создания и редактирования принципиальных схем устройства. По умолчаниюцвет фона окна черный. Изменить установки по умолчанию можно, выбрав команду Options>Preferencеs. После выбора данной команды открывается диалоговое окно Preferencеs (рис. 2). Оно содержит шесть вкладок, на которых можно установить
необходимые опции. При выводе этого окна активной является вкладка Circuit, на которой  имеются две панели Show и Color.
Панель Show содержит окно просмотра, в котором можно увидеть установленные опции, и шесть флажков, с помощью которых устанавливаются необходимые опции.
С помощью флажка Show component labels выбирают видимость или невидимость позиционного обозначения компонента на схеме. Для того чтобы установить видимость позиционного обозначения компонента на схеме, нужно щелкнуть левой клавишей мыши по белому квадрату, расположенному слева от имени флажка, Если флажок выбран, то в белом квадрате появляется галочка.
Следующими флажками устанавливают видимость на схеме:
Show component reference IDs – порядкового номера компонента;
Show node names – имени узла;
Show component values – номинала компонента;
Show component attribute – таблицы свойств компонента.
Флажок Adjust component identifiers позволяет при упорядочивании схемы изменять идентификационные номера однотипных компонентов, присвоенных программой автоматически в порядке их установки.

[image: Prefereces]

[bookmark: _Toc132447504][bookmark: _Toc132447598]Рисунок 2- Диалоговое окно Preferencеs с вкладкой Circuit


Панель Color содержит выпадающий список с именами команд, устанавливающих цвет фона, надписей и компонентов, окно просмотра, в котором можно просмотреть выбранный режим установки цвета, и пять кнопок, окрашенных в различные цвета, с помощью которых можно установить цвет для фона (Background), проводника (Wire), компонента, имеющего математическую модель (Component with model), компонента, не имеющего математическую модель (Component without model), и виртуального компонента (Virtual component).
На вкладке Workspaсe  (рис. 3) определяются настройки текущего окна.

[image: Prefereces1]

Рисунок 3- Диалоговое окно Preferencеs с вкладкой Worcspase
На панели Show  в окне, расположенном слева, отображаются результаты установки опций с помощью флажков, находящихся справа. Самый  верхний флажок – показывать (или нет) сетку (Show grid), второй сверху флажок –  показывать или нет границы страницы (Show page bounds), третий флажок – показывать или нет штамп страницы (Show title block).
На панели Sheet size (размер страницы схемы) в выпадающем списке выбирают формат страницы (А3, А4…). На панели Orientation устанавливают ориентацию страницы: портрет или альбомная (Landscape); на панели Custom size –  ширину и высоту страницы в дюймах или сантиметрах; на панели Zoom level – масштаб изображения.
На вкладке Wiring (рис. 4) устанавливают ширину проводников и степень автоматизации разводки проводников; на панели Wire width (drawing option) –  ширину линии. Результат отображается в окне.
На панели Autowire устанавливается (или нет) автоматическое соединение проводников (флажок Autowise on connection) и автоматическое движение (флажок Autowise on move) проводников.
[image: Prefereces2]

Рисунок 4- Диалоговое окно Preferencеs с вкладкой Wiring

На вкладке Component Bin (рис. 5) на панели Symbol standard устанавливается стандарт изображения компонентов ANCI (США) или DIN (Европа).

[image: Prefereces3]
Рисунок 5- Диалоговое окно Preferencеs с вкладкой Component Bin
На панели Component toolbar functionality указывают, изменять или нет цвет изображения компонента при его выборе.
На панели Place component mode выбирают режим размещения компонентов: единственный компонент (Place single component), непрерывное размещение многосекционного компонента  (Continuous placement for multi-section part only), непрерывное размещение (Continuous).
На вкладке Font (шрифт) (рис. 6) выбирают шрифт и его атрибуты для выбранных компонентов схемы.
[image: Prefereces4]

Рисунок 6- Диалоговое окно Preferencеs с вкладкой Font

На вкладке Miscellaneous (разное) (рис. 7) устанавливают режим автосохранения данных, пути к рабочему каталогу, идеальный или реальный режим моделирования (переключатели Ideal и Real на панели Digital Simulation Setting) цифровых схем, соединить или  рассоединить аналоговое и цифровое заземление (флажок Connect digital ground to analog ground на панели PCB Ground Option). 
Кроме того, окно Preferencеs содержит пять кнопок.
Для того чтобы записать выбранные опции для текущей схемы, нужно щелкнуть левой клавишей мыши по кнопке OK.
Для того чтобы записать выбранные опции, как устанавливаемые по умолчанию, нужно щелкнуть левой клавишей мыши по кнопке Set as Default, затем по кнопке  OK.
Для того чтобы вернутся к предыдущим опциям, установленным по умолчанию, нужно щелкнуть по кнопке Restore Default. Затем можно продолжить устанавливать новые опции.
[image: Prefereces5]
Рисунок 7- Диалоговое окно Preferencеs с вкладкой Miscellaneous

Чтобы остановить изменения и закрыть диалоговое окно, нужно щелкнуть по кнопке Cancel.
Пример создания новой схемы
Создание новой схемы рассмотрим на примере схемы, исследующей логическую схему «И» (рис. 8).
Прежде чем начать создание схемы, нужно запустить программу Multisim. Для этого в окне Windows нажать на кнопку Пуск, в открывшемся меню выбрать команду Программы. В новом открывшемся меню выбрать строку Multisim. Автоматически откроется окно программы, в котором будет расположена страница новой схемы. На этой странице и будет создана схема исследования логической схемы «И». 
[image: Лаб11]
[bookmark: _Toc132447505][bookmark: _Toc132447599]Рисунок 8- Схема исследования логической схемы «И»

Размещение компонентов на странице схемы
Для размещения компонентов служат кнопки панели инструментов, расположенной вертикально на левой стороне окна. По умолчанию эта панель видима. Если она не видима, то надо нажать кнопку Components на строке инструментов Design Bar. Компоненты, необходимые для создания схемы, сгруппированы в логические разделы (Parts Bin). Каждому логическому разделу соответствует кнопка на шкале инструментов. При нажатии на одну из этих кнопок открывается соответствующая панель (Parts Bin), содержащая кнопки для каждого компонента, входящего в семейство компонентов. Разместить компоненты можно также с помощью команды Place>Place Component.
Разместите на странице схемы компонент источника постоянного напряжения +5 В. Для этого необходимо:
1. Нажать на кнопку Sources. Откроется панель, содержащая источники напряжения или тока (рис. 9). Удерживая курсор на кнопке, не щелкая по ней, можно увидеть название кнопки.
2. Щелкнуть по кнопке Vcc. Курсор примет форму выбранного компонента. Поместить выбранный компонент на схему и щелкнуть левой клавишей мыши по точке схемы, в которой должен быть расположен компонент, изображение компонента появится на схеме.
 (
Рис. 9
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)3. Если необходимо изменить свойства компонента (порядковый номер, имя и величину значения), то  дважды щелкнуть по изображению компонента. Откроется диалоговое окно Digital Power (рис. 10). Название окна зависит от назначения компонента. Это окно содержит четыре вкладки. По умолчанию открыта вкладка Value, на которой расположены текстовая строка и выпадающий список.
По умолчанию значение напряжения источника равно 12 В. Напряжение питания микросхем серии  74ххХХ равно 5 В. Поэтому нужно в текстовой строке вкладки вместо цифры 12 ввести 5, затем щелкнуть по кнопке OK.
В выпадающем списке указаны единицы измерения.
На вкладке Lable (рис. 11) в текстовой строке Reference ID указывается название компонента. 

[image: DigPow2]

Рисунок 11- Диалоговое окно Digital Power с вкладкой Label

На вкладке Display имеется пять флажков (рис. 12), устанавливающих видимость:
Use Schematic Option global setting – всех надписей компонента;
Show labels – ярлыка компонента;
Show values – величины значения компонента;
Show reference ID – порядкового номера компонента;
Show Attributes – таблицы свойств.
Если установлен флажок Use Schematic Option global setting, то остальные флажки имеют серый цвет и не доступны.

[image: DigPow3]

Рисунок 12- Диалоговое окно Digital Power с вкладкой Display

На вкладке Fault (погрешность) (рис. 13) устанавливают границы погрешности.

[image: DigPow4]
Рисунок 13- Диалоговое окно Digital Power с вкладкой Fault

Чтобы разместить на схеме изображения четырех компонентов «НЕ» и одного компонента «И», необходимо: 
 (
Рис.14
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Digital
)[image: MiscDigi]1. Нажать кнопку Misс Digital. Откроется панель с соответствующими компонентами (рис. 14).
2. Нажать на кнопку с изображением логического элемента. Откроется диалоговое окно  Component Browser  (рис. 15), в котором имеется окно просмотра Component Name List, содержащее список цифровых компонентов. Во втором окне Symbol появляется изображение выбранного компонента в формате ANSI (США) или DIN (Европа).
3. В списке компонентов выбрать компонент 2И (AND2) и поместить его на схему, щелкнув по кнопке OK. Ускорить поиск компонента можно, если ввести несколько первых символов имени компонента в строку  Component Nave.
4. В списке компонентов выбрать компонент НЕ (NOT) и расположить четыре образца этого компонента на схеме.

[image: CompBrow]
Рисунок 15- Диалоговое окно Component Browser

Поместить на схему несколько копий одного и того же компонента можно двумя способами:
· повторить несколько раз действия, описанные в п. 3;
· воспользоваться списком компонентов, размещенных на схеме ранее. Для этого открыть список In Use List, в строке System toolbar, нажав на черный треугольник, расположенный в окне списка справа. Выбрать в этом списке нужный компонент и поместить его на схему.
 (
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)[image: Electro]Разместить на схеме два переключателя на два положения. Для этого необходимо:
1. Нажать кнопку Electro. Откроется панель с соответствующими компонентами (рис. 16).
2. Выбрать кнопку SUPPLEMENTARY_CONTACTS. Откроется диалоговое окно  Component Browser (рис. 17).
3. В окне просмотра (рис. 17) Component Name List выбрать компонент SPDT_SB и поместить два образца этого компонента на схему (как описано выше). 

[image: CompBrow2]
Рисунок 17. Диалоговое окно Component Browser

4. При необходимости повернуть эти образцы компонента на нужный угол по горизонтали или по вертикали, или на 90° вправо или влево. Чтобы сделать это, необходимо: 
1) щелкнуть правой клавишей мыши по компоненту. Откроется всплывающее меню (рис. 18);
2) в этом меню выбрать нужную строчку и щелкнуть левой клавишей мыши по этой строке.
Разместить на схеме три светодиода. Для этого необходимо:
1. Нажать кнопку Indicator. Откроется панель инструментов Indicator (рис. 19).
2. Щелкнуть по кнопке с изображением светодиода и поместить три образца этого компонента на схему.
3. При необходимости повернуть эти образцы компонента на нужный угол (как описано выше).
 (
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Схема, содержащая цифровые компоненты, должна включать источник напряжения VCC и символ «цифровая земля» (Digital ground), которые Multisim использует для подачи питания на цифровые компоненты.
Разместить на схеме изображение символ «земля». Для этого необходимо:
1. Нажать на кнопку Sources. Откроется панель, содержащая источники напряжения или тока (рис. 9) и символы «земля».
2. Поместить на схему символы «земля» и «цифровая земля», нажав кнопки Ground и Didgital_Gnd соответственно.
Разместить на схеме изображение вольтметра. Для этого необходимо:
1. Нажать кнопку Indicator. Откроется панель инструментов Indicator (рис. 19).
2. Поместить на схему вольтметр, нажав на кнопку Voltmeter.
[bookmark: _Toc132447506][bookmark: _Toc132447600]В результате страница схемы будет выглядеть как показано на рис. 20.

[bookmark: _Toc132447507][bookmark: _Toc132447601][image: ПромСх]

[bookmark: _Toc132447508][bookmark: _Toc132447602]Рисунок 20- Страница схемы с размещенными на ней компонентами

[bookmark: _Toc132447509][bookmark: _Toc132447603]Используя команду File>Save, записать страницу схемы с размещенными на ней компонентами.

      Соединение компонентов проводниками
После того как компоненты размещены на схеме, их необходимо соединить проводниками. Все компоненты имеют выводы, которые используются для этих целей. Соединить компоненты проводниками можно двумя способами: автоматически и вручную. При автоматическом соединении программа выбирает наилучший путь между двумя соединяемыми выводами компонентов, т.е. программа избегает размещения проводников через другие компоненты или частичного перекрывания проводников. При ручном соединении компонентов пользователь должен сам контролировать путь проводника на схеме. При разводке одного проводника можно комбинировать эти два метода, например, начать разводку проводника вручную и затем позволить программе закончить ее.
Для автоматического соединения двух компонентов необходимо:
1. Щелкнуть по выводу первого компонента, например «земля». Изображение курсора измениться на крест, показывая, что программа находится в режиме разводки. 
2. Щелкнуть по первому выводу второго компонента логической схемы «НЕ» (U4), к которому необходимо присоединить проводник. Соединение выводов первого и второго компонентов произойдет автоматически. Затем изображение курсора примет первоначальный вид и можно выполнять очередные команды.
3. Повторять эти шаги до тех пор, пока все выводы всех компонентов не будут соединены нужным образом.  
Соединить первый вывод компонента U2 и первый вывод компонента  U1.
Чтобы удалить проводник, соединяющий два вывода, нужно щелкнуть по проводнику правой клавишей мыши и из всплывающего меню выбрать команду Delete или нажать клавишу Delete.
Для более точного определения пути проводника, соединяющего два вывода, используется ручная разводка. Программа предотвращает присоединение двух проводников к одному выводу, что исключает возможные ошибки соединения. Поэтому в этом случае начинать разводку проводника нужно не на выводах компонентов, а в какой-нибудь точке проводника, соединяющего эти выводы. Для этого нужно добавить точку соединения (junction) к данной точке, т.е. необходимо:
1) выбрать команду Place>Place Junction. В точке проводника, на которой остановлен курсор, появится легкое  изображение точки;
2) передвинуть изображение точки в нужное место проводника и щелкнуть левой клавишей мыши. На проводнике появится точка.
Соединять выводы компонентов проводниками вручную удобнее, если в редакторе схемы видна сетка. Для того чтобы сделать сетку видимой, если она не видима, нужно щелкнуть правой клавишей мыши в какой-нибудь точке редактора схемы и из всплывающего меню выбрать команду Show Grid.
Для того чтобы выполнить соединение двух выводов вручную, необходимо:
1. Щелкнуть по точке соединения, только что размещенной на проводнике. Изображение курсора изменится на крест, показывая, что программа находится в режиме разводки проводников.
2. Перетащить курсор к выводу другого компонента и щелкнуть левой клавишей мыши. Это фиксирует проводник на его месте.
3. Если нужно изменить направление перемещения проводника, то щелкнуть левой клавишей мыши в точке изменения направления движения. Маленькие черные квадраты показывают точки изменения направления движения.
4. Если необходимо переместить проводник на другое место, нужно щелкнуть в любой точке проводника и передвинуть этот сегмент проводника.

Режим моделирования схемы
После создания принципиальной схемы исследуемого устройства необходимо запустить процесс моделирования, чтобы исследовать поведение устройства.
· Для того чтобы запустить процесс моделирования, нужно щелкнуть по кнопке Simulate [image: КнПуск] и из всплывающего меню выбрать команду Run. Слева от команды Run появится галочка, означающая, что процесс моделирования начался.
· Для того чтобы приостановить на время процесс моделирования, нужно щелкнуть по кнопке Simulate [image: КнПуск] и из всплывающего меню выбрать команду Pause. Для возобновления процесса моделирования нужно щелкнуть по кнопке Simulate [image: КнПуск] и из всплывающего меню снова выбрать команду Pause. Процесс моделирования возобновиться с того момента, когда он был остановлен.
· Для того чтобы остановить  процесс моделирования, следует щелкнуть по кнопке Simulate [image: КнПуск] и из всплывающего меню выбрать команду Run. Галочка слева от команды Run исчезнет, показывая, что процесс моделирования остановлен. Если после остановки процесса моделирования запустить его снова, то, в отличие от действия команды Pause, процесс моделирования начнется из начальной точки.
· Процесс моделирования можно запустить или приостановить с помощью команд Simulation>Run и Simulation>Pause соответственно.
· Процесс моделирования можно запускать и останавливать с помощью переключателя, который можно сделать видимым или невидимым с помощью команды View>Show Simulation Switch.

Контрольные вопросы
1 Что входит в панель библиотек компонентов?
2 Сколько команд содержит меню Simulate?
3 Редактор схем – это?


































Лабораторная работа № 2, 3
[bookmark: _Toc132447604]«Исследование логических схем»

Цель работы: научиться исследовать логические схемы «2И», «И-НЕ», «ИЛИ», «ИЛИ-НЕ», «Исключающее ИЛИ».
Образовательные результаты, заявленные во ФГОС третьего поколения:
Студент должен 
уметь: 
 - Строить и использовать таблицы истинности логических функций, элементов устройств;
знать: 
-  Типовые узлы и устройства ЭВМ, взаимодействие аппаратного и программного обеспечения ЭВМ

Краткие теоретические и учебно-методические материалы по теме лабораторной работы
Аксиомы алгебры логики
Переменные, рассматриваемые в алгебре логики, могут принимать только два значения ноль или единица. В алгебре логики определены:
· отношение эквивалентности, обозначаемое знаком = ;
· операция сложения (дизъюнкция), обозначаемая знаком + или  ;
· операция умножения (конъюнкция), обозначаемая знаком & или * ;
· операция отрицания (или инверсия), обозначаемая знаком надчеркивания или апострофом ’ .
Алгебра логики определяется следующей системой аксиом:


x = 0, если х  1,              = 1,

x = 1, если х  0,              = 0,
       1+ 1 = 1,                            0 * 0 = 0,
       0 + 0 = 0,                             1 * 1 = 1,
                      0 + 1 = 1 + 0 = 1,                1 * 0 = 0 * 1 + 0.

Логические выражения
Логические выражения связывают значение логической функции со значениями логических переменных. Они могут записываться или в конъюнктивной или дизъюнктивной нормальных формах. В дизъюнктивной форме логические выражения записываются как логическая сумма логических произведений, в конъюнктивной – как логическое  произведение  логических сумм. Порядок действий в логических выражениях такой же, как и в обычных алгебраических выражениях. Логические выражения связывают значение логической функции со значениями логических переменных.
Законы булевой алгебры
Они вытекают из аксиом и имеют две формы выражения: для конъюнкции и дизъюнкции. Эти законы используются при преобразованиях логических выражений. 


Переместительный закон:   ;          ;



сочетательный закон: ;  ;



распределительный закон: ;   ; 


закон повторения:       


закон обращения:   если , то ;

закон двойной инверсии:    


закон универсального множества:       


закон дополнительности:   ;    ;


закон нулевого множества:       ;


закон поглощения:     


закон склеивания:      ;


закон инверсии (закон Де Моргана):    .
Логические функции

Любое логическое выражение, составленное из n переменных xn,, xn-1, …, x1 c помощью конечного числа операций алгебры логики, можно рассматривать как некоторую функцию n переменных, называемую логической. В соответствии с аксиомами алгебры логики функция может принимать в зависимости от значения переменных значение 0 или 1. Функция n логических переменных может быть определена для  2n значений переменных, соответствующих всем возможным значениям n-разрядных двоичных чисел.
Основной интерес представляют следующие функции двух переменных x и y:
f1(x,y) = x*y  – логическое умножение,
f2(x,y) = x + y  – логическое сложение,

f3(x,y) =  – логическое умножение с инверсией,

f4(x,y) =  – логическое сложение с инверсией,

f5(x,y) =  – суммирование по модулю два или «Исключающее  ИЛИ»,

f6(x,y) =   – равнозначность.

Логические схемы

Физическое устройство, реализующее одну из операций алгебры логики или простейшую логическую функцию, называется логическим элементом. Схема, составленная из конечного числа логических элементов по определенным правилам, называется логической. Основным логическим функциям соответствуют выполняющие их схемные элементы. Например, функции f1(x,y) соответствует логическая схема «И», функции f2(x,y) – логическая схема «ИЛИ», функции f3(x,y) – логическая схема «И-НЕ», функции f4(x,y) – логическая схема «ИЛИ-НЕ». 

Таблица истинности
Так как область определения любой функции n переменных конечна (может принимать 2n значений), то такая функция может быть задана таблицей значений f(x), которые она принимает в точках xi, где i= 0,1, …, 2n-1. Такие таблицы называются таблицами истинности. В табл. 1 представлены значения функций 
f1(x,y), …, f6(x,y).
Т а б л и ц а  1
	

i
	Значения переменных
	Функции

	
	x
	y
	f1(x,y)
	f2(x,y)
	f3(x,y)
	f4(x,y)
	f5(x,y)
	f6(x,y)

	0
	0
	0
	0
	0
	1
	1
	0
	1

	1
	0
	1
	0
	1
	1
	0
	1
	0

	2
	1
	0
	0
	1
	1
	0
	1
	0

	3
	1
	1
	1
	1
	0
	0
	0
	1



Инструкция по выполнению лабораторной работы

1.Исследование логической функции «И»

1. Нарисовать схему исследования функции «И» (рис. 21).

[image: Лаб11]
Рисунок 21- Схема исследования функции «2И»

Схема содержит исследуемую функцию «И» (U1), два двухпозиционных переключателя (S1, S2), управляемые клавишами А и В (заглавные буквы латинского алфавита), источники сигналов логической единицы (U2,U4), логического нуля (U3,U5), три светодиода (X1, X2, X3), два вольтметра и источник постоянного напряжения 5В (VCC).
2. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]  на панели инструментов, и в появившемся меню выбрать команду Run.
3. Подать на входы схемы «И» все возможные комбинации уровней сигналов А и В с помощью переключателей S1 и S2. И для каждой комбинации зафиксировать показания вольтметров и уровни входных сигналов А и В и уровень  выходного сигнала Q (логическая единица – соответствующий светодиод  Хi  светится, логический ноль – соответствующий светодиод Хi не светится). Результаты измерений занести в таблицу истинности (табл. 2).
Т а б л и ц а  2
	Входы
	Выход

	А
	В
	Q

	0
	0
	

	0
	1
	

	1
	0
	

	1
	1
	



2.Исследование логической функции «И-НЕ»

1. Нарисовать схему исследования функции «2И-НЕ» (рис. 22).
[image: Лаб12]
Рисунок 22- Схема исследования функции  «2И-НЕ»
2. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]   на панели инструментов, и в появившемся меню выбрать команду Run.
3. Подать на входы схемы «И-НЕ» все возможные комбинации уровней сигналов А и В с помощью переключателей S1 и S2. И для каждой комбинации зафиксировать показания вольтметров, уровни входных сигналов А и В и уровень  выходного сигнала Q (логическая единица –  соответствующий светодиод  Хi  светится, логический ноль – соответствующий светодиод Хi не светится). Результаты измерений занести в таблицу истинности (табл. 3).
Т а б л и ц а  3
	Входы
	Выход

	А
	В
	Q

	0
	0
	

	0
	1
	

	1
	0
	

	1
	1
	



3.Исследование логической функции «ИЛИ»

1. Нарисовать схему исследования функции «2ИЛИ» (рис. 23).
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Рисунок 23- Схема исследования функции  «2ИЛИ»
2. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]  на панели инструментов, и в появившемся меню выбрать команду Run.
3. Подать на входы схемы «ИЛИ» все возможные комбинации уровней сигналов А и В с помощью переключателей S1 и S2. И для каждой комбинации зафиксировать показания вольтметров, уровни входных сигналов А и В и уровень  выходного сигнала Q (логическая единица –  соответствующий светодиод  Хi  светится, логический ноль – соответствующий светодиод Хi не светится). Результаты измерений занести в таблицу истинности (табл. 4).
Т а б л и ц а  4
	Входы
	Выход

	А
	В
	Q

	0
	0
	

	0
	1
	

	1
	0
	

	1
	1
	



4.Исследование логической функции «ИЛИ-НЕ»
1. Нарисовать схему исследования функции «2ИЛИ-НЕ» (рис. 24).
[image: Лаб14]
Рисунок 24- Схема исследования функции  «2ИЛИ-НЕ»
2. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]  на панели инструментов, и в появившемся меню выбрать команду Run.
3. Подать на входы схемы «ИЛИ-НЕ» все возможные комбинации уровней сигналов А и В с помощью переключателей S1 и S2. И для каждой комбинации зафиксировать показания вольтметров, уровни входных сигналов А и В и уровень  выходного сигнала Q (логическая единица – соответствующий светодиод  Хi  светится, логический ноль – соответствующий светодиод Хi не светится). Результаты измерений занести в таблицу истинности (табл. 5).
Т а б л и ц а  5
	Входы
	Выход

	А
	В
	Q

	0
	0
	

	0
	1
	

	1
	0
	

	1
	1
	



5.Исследование логической функции «Исключающее ИЛИ»
1. Нарисовать схему исследования функции «Исключающее ИЛИ» (рис. 25).
[image: Лаб15]
Рисунок 25- Схема исследования функции  «Исключающее ИЛИ»
2. Запустить процесс моделирования, нажав кнопку  [image: КнПуск] на панели инструментов, и в появившемся меню выбрать команду Run.
3. Подать на входы схемы «Исключающее ИЛИ» все возможные комбинации уровней сигналов А и В с помощью переключателей S1 и S2. И для каждой комбинации зафиксировать показания вольтметров, уровни входных сигналов А и В и уровень  выходного сигнала Q (логическая единица – соответствующий светодиод  Хi  светится, логический ноль – соответствующий светодиод Хi не светится). Результаты измерений занести в таблицу истинности (табл. 6).
Т а б л и ц а  6
	Входы
	Выход

	А
	В
	Q

	0
	0
	

	0
	1
	

	1
	0
	

	1
	1
	



Контрольные вопросы:
1 Назовите назначение схемы «2И»?
2 Перечислите особенности схемы «И-НЕ»? 
3 Для чего предназначен схема «2И-НЕ»?
4 Охарактеризуйте схему «2ИЛИ»?
5 Для чего предназначен схема «ИЛИ-НЕ»?
6 Для чего используется схема «2ИЛИ-НЕ»?
7 Схема «Исключающее ИЛИ» - это схема











Лабораторная работа № 4, 5
[bookmark: _Toc132447605]«Исследование регистров, счетчиков и дешифраторов»

Цель работы: научиться исследовать регистры, счетчики и дешифраторы. 

Образовательные результаты, заявленные во ФГОС третьего поколения:
Студент должен 
уметь: 
 - строить и использовать таблицы истинности логических функций, элементов устройств;
знать: 
-  типовые узлы и устройства ЭВМ, взаимодействие аппаратного и программного обеспечения ЭВМ

Краткие теоретические и учебно-методические материалы по теме лабораторной работы
          Триггерами называются устройства, обладающие двумя устойчивыми состояниями  (Q = 1 и Q = 0) и способные находиться в одном из них сколь угодно долго и переходить из одного состояния в другое под воздействием внешних сигналов. В каком из этих состояний окажется триггер, зависит от сигналов на входах триггера и от его предыдущего состояния, т.е. он имеет память. Таким образом, триггер – элементарная ячейка памяти.
Тип триггера определяется алгоритмом его работы, в зависимости от которого триггер может иметь установочные, информационные и управляющие входы. Установочные входы обуславливают состояние триггера независимо от состояния других входов. Входы управления разрешают запись данных, подающихся на информационные входы. Наиболее распространенными являются триггеры RS-, JK-, D- и T-типов.
RS-триггер – простейший автомат с памятью, который может находиться в двух состояниях. Триггер имеет два установочных входа: установки S (set – установка) и сброса R (reset – сброс), на которые подаются входные сигналы от внешних источников.  При подаче на установки активного логического уровня триггер устанавливается в единицу (Q = 1, Q′ = 0, здесь штрих означает инвертирование), при подаче активного уровня на вход сброса  триггер устанавливается в ноль (Q = 0, Q′ = 1). Если на оба установочных входа подать пассивный логический уровень, то триггер сохраняет предыдущее состояние выходов: Q = 1  или Q = 0. Каждое состояние устойчиво и поддерживается за счет действия обратных связей. Подача активного уровня одновременно на оба установочных входа запрещена, так как триггер не может быть установлен в ноль и единицу.
RS-триггер может быть выполнен на элементах «ИЛИ-НЕ» или «И-НЕ» (рис. 26).

[image: RSтриг]
а	б
Рисунок 26- RS-триггер: а – на элементах «ИЛИ-НЕ», б – на элементах «И-НЕ»

Для RS-триггеров, выполненных на элементах «ИЛИ-НЕ», активным уровнем на управляющих входах является уровень логической единицы, а  на элементах «И-НЕ» – уровень логического нуля.
RS-триггер – основной узел построения последовательных схем. Условия переходов триггеров из одного состояния в другое можно описать табличным, аналитическим или графическим способами. Табличное описание работы RS-триггера на элементах «ИЛИ-НЕ» и «И-НЕ» представлено в табл. 7 и 8 соответственно, где Qt – предшествующее состояние выхода; Qt+1 – новое состояние, устанавливающееся после перехода;  -  – неопределенное состояние.
 Т а б л и ц а  7                                            Т а б л и ц а  8
	R
	S
	Qt+1
	
	R
	S
	Qt+1

	0
	0
	Qt
	
	0
	0
	–

	1
	0
	0
	
	1
	0
	1

	0
	1
	1
	
	0
	1
	0

	1
	1
	–
	
	1
	1
	Qt



Триггер JK-типа имеет более сложную структуру и более широкие возможности по сравнению в RS-триггером. Кроме информационных входов J и K  и прямого и инверсного выходов Q и Q′, JK-триггер имеет вход управления C (тактирующий или счетный) и два асинхронных установочных входа  R и S. Обычно активными уровнями установочных сигналов являются нули. Установочные входы имеют приоритет над остальными входами. Активный уровень сигнала на входе S устанавливает триггер в состояние единица (Q = 1), а на входе R в состояние ноль (Q = 0), независимо от сигналов на остальных входах. Если на входы установки подать пассивный уровень сигнала, то состояние триггера будет изменяться по фронту импульса на счетном входе в зависимости от состояния входов J и K. 
Один из вариантов функциональной схемы JK-триггера и его условное графическое изображение приведены на рис. 27, временные диаграммы его работы при R=S=1 – на рис. 28.
[image: JKтриг]
а	б

Рисунок 27- JK-триггер: а – функциональная схема; б – условное 
графическое обозначение

[image: JKврдиагр]
Рисунок 28- Временная диаграмма работы JK-триггера

D-триггер имеет один информационный вход D (data – данные) и один счетный вход C. Информация с входа D записывается  в триггер по положительному перепаду импульса на счетном входе и сохраняется до следующего положительного перепада. Кроме счетного C и информационного D входов, у триггера есть два асинхронных установочных входа R и S.  Установочные входы приоритетные. Активный уровень сигнала на входе S устанавливает триггер в состояние единица (Q=1), а на входе R в состояние ноль (Q=0), независимо от сигналов на остальных входах.
Условное обозначение D-триггера с диаграммами входных и выходных сигналов приведено на рис. 29.
[image: D-триг]
а	б

Рисунок 29- D-триггер: а – условное обозначение; б – временные диаграммы

T-триггер, или счетный триггер, – устройство, осуществляющее счетный режим. Такие схемы можно построить на основе JK- или D-триггеров. 
В D-триггере счетный режим (рис. 30,а) реализуется  при помощи обратной связи, когда на вход D подается сигнал с инверсного выхода триггера, т.е. всегда осуществляется неравенство сигналов на входе D и на выходе Q (если Q=1, D=0 и наоборот). Следовательно, при каждом положительном перепаде сигнала на счетном входе С состояние выхода будет изменяться на противоположное.
[image: D-триг]
а	б

Рисунок 30- T-триггер: а – условное обозначение; б – временная диаграмма

Таким образом, на каждые два входных тактовых импульса T-триггер формирует один период выходного сигнала Q, т.е. период выходного сигнала в два раза больше периода входного сигнала. Следовательно, триггер осуществляет деление частоты 
fт  на его входе на две:  fQ = fт/2, где fQ – частота следования импульсов на выходе триггера.
Регистры
Триггерным регистром называется совокупность триггеров с определенными связями между ними, при которых они действуют как единое устройство. Регистры выполняются на синхронных триггерах JK- или D-типа. В зависимости от выполняемых функций регистры делятся на накопительные (параллельные) и сдвигающие.
В последовательном регистре выход предыдущего триггера подается на вход следующего триггера, а тактовые импульсы подаются на входы С всех триггеров, составляющих регистр, одновременно (рис. 31). При этом содержимое каждого триггера записывается в последующий триггер. Такие регистры называются  сдвиговыми регистрами, или регистрами сдвига.

[image: Регистр]
Рисунок 31 - Последовательный регистр (регистр сдвига)

Если на вход D регистра сдвига подать единицу, а на вход С тактовую частоту, то единица начнет продвигаться по регистру сдвига, т.е. под воздействием первого тактового импульса единица запишется в первый триггер регистра. Под воздействием второго тактового импульса эта единица перепишется во второй триггер и т.д., когда под воздействием N-го тактового импульса единица не выйдет из регистра сдвига. Временная диаграмма работы четырехразрядного регистра сдвига приведена на рис. 32.

[image: врдиагРег]
Рис. 32. Временная диаграмма четырехразрядного регистра сдвига
Виды регистров сдвига: 
· с последовательным вводом и выводом;
· с последовательным вводом и параллельным выводом;
· с параллельным вводом и последовательным выводом;
· с переменным направлением сдвига (реверсивные регистры сдвига).
 (
Рис. 33. 
Параллельный регистр
)[image: РегПар]Кроме последовательных регистров сдвига существуют параллельные регистры, в 
которых информация подается одновременно на все N триггеров и считывается одновременно с выходов всех триггеров регистра (рис. 33). Тактовая частота подается одновременно на все триггеры.
Параллельные регистры используются для хранения двоичной информации небольшого объема в течение короткого промежутка времени.

 Счетчики
Счетчиком называется устройство, подсчитывающее число входных импульсов. Число, представляемое состоянием его выходов по фронту каждого входного импульса, изменяется на единицу. Счетчик состоит из n последовательно соединенных счетных триггеров, причем выход одного счетного триггера соединен с тактовым входом следующего триггера. Счетчики бывают суммирующими (прямой счет) и вычитающими (обратный счет). В суммирующих счетчиках каждый входной импульс увеличивает число на его выходах на единицу, в вычитающих счетчиках уменьшает это число на единицу. Для того чтобы построить суммирующий счетчик, необходимо счетный вход очередного триггера подключить  к  инверсному  выходу  предыдущего  (рис. 34).
[image: Лаб2Сч]
[image: ДиагрРабСч]

Рисунок 34- Суммирующий счетчик и диаграмма его работы

Для того чтобы изменить направление счета (реализовать вычитающий счетчик), необходимо счетный вход очередного триггера подключить к прямому выходу предыдущего, при этом изменяется последовательность переключения триггеров (рис. 35). 
[image: врдиагСч2]

Рисунок 35- Вычитающий счетчик и диаграмма его работы

Счетчик характеризуется числом состояний в течение одного периода (цикла). Для двоичных счетчиков полный цикл счета N=2n от состояния 0..000 до состояния 1…11.  Число состояний называется коэффициентом пересчета Kсч, равным отношению числа импульсов Nс на входе к числу импульсов NQст на выходе старшего разряда за период:

.
Если на вход счетчика подавать периодическую последовательность импульсов с частотой fс, то частота fQ на выходе старшего разряда счетчика будет меньше в Kсч  раз: Kсч= fс/fQ. Поэтому счетчики также называют делителями частоты, а Kсч – коэффициентом деления. Для увеличения величины Kсч нужно увеличить число триггеров в цепочке. Каждый дополнительный триггер удваивает число состояний счетчика и число Kсч. 
 
Дешифраторы

Комбинационной называется логическая схема, реализующая однозначное соответствие между значениями входных и выходных сигналов. Дешифратор – логическая комбинационная схема, имеющая n информационных входов и 2n выходов. Каждой комбинации логических уровней на входах будет соответствовать активный уровень на одном из 2n выходов. Как любая логическая схема, дешифратор может быть задан таблицей истинности. Таблица истинности дешифратора 3х8 (табл. 9) состоит из трех столбцов, соответствующих входным сигналам Х0, Х1, Х2, и восьми столбцов, соответствующих выходным сигналам Y0, Y1, Y2, Y3, Y4, Y5, Y6, Y7. В первых слева трех столбцах расположены возможные комбинации входных сигналов, а в последних восьми – соответствующие им комбинации выходных сигналов.
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	Y5
	Y4
	Y3
	Y2
	Y1
	Y0

	0
	0
	0
	0
	0
	0
	0
	0
	0
	0
	1

	0
	0
	1
	0
	0
	0
	0
	0
	0
	1
	0

	0
	1
	0
	0
	0
	0
	0
	0
	1
	0
	0

	0
	1
	1
	0
	0
	0
	0
	1
	0
	0
	0

	1
	0
	0
	0
	0
	0
	1
	0
	0
	0
	0

	1
	0
	1
	0
	0
	1
	0
	0
	0
	0
	0

	1
	1
	0
	0
	1
	0
	0
	0
	0
	0
	0

	1
	1
	1
	1
	0
	0
	0
	0
	0
	0
	0


Схема имеет восемь выходов, на одном из которых потенциал высокий, на остальных  низкий. Номер единственного выхода, имеющего высокий потенциал, соответствует двоичному числу, формируемому состояниями входных сигналов. Этот принцип формирования выходного сигнала можно описать следующим образом: Yi = 0, если i = k; Yi = 1, если i ≠ k, здесь i – номер разряда; k = 22 X2 + 21 X1 + 20X0. 
Выражения для каждого выхода дешифратора:


где «¯» – инвертирование.
Таким образом, схема дешифратора должна содержать три схемы «НЕ» и восемь схем «3И» (рис. 36).

[image: Дешифр]
Рисунок 36- Схема дешифратора 3х8
Инструкция по выполнению лабораторной работы
       1.Исследование регистра
1. Нарисовать схему четырехразрядного регистра сдвига 
с автоматической записью единицы в первый разряд регистра (рис. 37).

[image: Лаб2Рег]
Рисунок 37- Четырехразрядный регистр сдвига с автоматической записью единицы

Схема содержит четыре D-триггера, четыре светодиода, одну логическую схему «4ИЛИ-НЕ», функциональный генератор и логический анализатор. Логическая схема «4ИЛИ-НЕ» служит для автоматической записи единицы в регистр. На выходе этой схемы единица будет только тогда, когда все разряды регистра будут находиться в нулевом состоянии.
2. Открыть окно функционального генератора и установить вид генерируемых сигналов (прямоугольные импульсы), генерируемую частоту  1000 Гц, амплитуду генерируемых импульсов 5 В.
3. Открыть  окно логического анализатора, дважды щелкнув по иконке логического анализатора.
4. Запустить процесс моделирования, нажав кнопку  [image: КнПуск] на панели инструментов, и в появившемся меню выбрать команду Run.
5. Зарисовать диаграммы сигналов с экрана логического анализатора.
6. Зарисовать все состояния светодиодов и сравнить их с временными диаграммами.
Описание используемых контрольно-измерительных приборов
Функциональный генератор (Function Generator) 
 (
Рис. 38. 
Лицевая панель 
функционального генератора
)[image: ФункГенер]На лицевой панели функционального генератора (рис 38) расположены три кнопки [image: ФункГенер1], с помощью которых выбирается форма генерируемого сигнала: синусоидальной (выбирается по умолчанию), треугольной и прямоугольной.
В четырех белых окнах устанавливают параметры выходного сигнала:
· частоты – [image: ФункГенер2],
· коэффициента заполнения в процентах. Для импульсных сигналов  это отношение длительности импульса к периоду повторения (величина обратная скважности), для треугольных сигналов – соотношение между длительностями переднего и заднего фронтов – [image: ФункГенер3],
· амплитуды выходного сигнала – [image: ФункГенер4],  
· смещения (постоянной составляющей) – [image: ФункГенер5].
В низу лицевой панели расположены выходные зажимы [image: ФункГенер6]; при заземлении клеммы COM (общий) на клеммах «+» и «-» генератор выдает парафазный сигнал.

Логический анализатор (Logic Analyzer)
Логический анализатор предназначен для отображения на экране монитора 16-разрядных кодовых последовательностей одновременно в шестнадцати точках схемы, а также в виде двоичных чисел на входных клеммах-индикаторах (рис. 39).
[image: Логич анализ]
Рисунок 39- Лицевая панель логического анализатора

Анализатор снабжен двумя визирными линейками для точных отсчетов временных интервалах Т1, Т2 и Т2 – Т1 (окно в поле Т1, Т2, Т2-Т1), а также линейкой прокрутки по горизонтали для просмотра осциллограмм на большом временном интервале.
На панели Clock в строке Clocks/Div задается длительность развертки. В этом блоке имеются клеммы для подключения как обычного (Extend), так и избирательного (Qualifier) источника запускающих сигналов, параметры  которых устанавливаются с помощью меню, вызываемого кнопкой Set.
В окне Trigger можно задать логические сигналы 1, 0 и Х, при наличии которых производится запуск анализатора.
Кнопки Stop и Reset предназначены для остановки и перезапуска режима моделирования.
Исследование суммирующего счетчика
1. Нарисовать схему четырехразрядного счетчика, считающего в прямом направлении (рис. 40).

[image: Лаб2Счет1]
Рисунок 40 - Четырехразрядный суммирующий счетчик

Поместить на схему четыре D-триггера, четыре светодиода, функциональный генератор, логический анализатор и 16-ричный индикатор. 
2. Открыть окно логического анализатора, щелкнув по иконке логического анализатора.
3. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]  на панели инструментов, и в появившемся меню выбрать команду Run.
4. Зарисовать диаграммы сигналов с экрана логического анализатора.
5. Зарисовать все состояния светодиодов и сравнить их с временными диаграммами.
6. Наблюдать за показаниями 16-ричного индикатора и сравнить его показания с соответствующими состояниями светодиодов.
Исследование вычитающего счетчика
1. Нарисовать схему четырехразрядного счетчика, считающего в обратном направлении (рис. 41).

[image: Лаб2Счет2]
Рисунок 41 - Четырехразрядный вычитающий счетчик
2. Открыть окно логического анализатора, щелкнув по иконке логического анализатора.
3. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]  на панели инструментов, и в появившемся меню выбрать команду Run.
4. Зарисовать диаграммы сигналов с экрана логического анализатора.
5. Зарисовать все состояния светодиодов и сравнить их с временными диаграммами.
6. Наблюдать за показаниями 16-ричного индикатора и сравнить его показания с соответствующими состояниями светодиодов.
Исследование дешифратора
1. Нарисовать схему дешифратора 3х8 (рис.42). Для этого поместить на схему восемь логических схем «3И», восемь светодиодов, пять логических схем «НЕ», три переключателя на два направления и три вольтметра.
2. Присвоить переключателям управляющие клавиши.
3. С помощью переключателей подать на вход дешифратора все возможные комбинации сигналов и записать для каждого входного сигнала выходной сигнал (восьмиразрядную комбинацию), т.е. заполнить таблицу истинности.

[image: Лаб22]

Рисунок 42 - Дешифратор 3х8
Контрольные вопросы
1 Назовите назначение регистра?
2 Перечислите особенности триггеров?
3 Для чего используется RS-Триггер?
4 Для чего предназначен JK –Триггер?
5 Охарактеризуйте D – Триггер?
6 Назовите назначение D- Триггера?
7 Счетчики это устройство выполняющее?
8 Для чего используется дешифраторы?













[bookmark: _Toc132447606]Лабораторная работа № 6, 7
«Исследование генератора псевдослучайной последовательности»

Цель работы:  научиться исследовать генератор псевдослучайной последовательности.

Образовательные результаты, заявленные во ФГОС третьего поколения:
Студент должен 
уметь: 
 - Строить и использовать таблицы истинности логических функций, элементов устройств;
знать: 
-  Типовые узлы и устройства ЭВМ, взаимодействие аппаратного и программного обеспечения ЭВМ

Краткие теоретические и учебно-методические материалы по теме лабораторной работы
Регистры сдвига (сдвигающие регистры) являются одними из основных узлов аппаратуры передачи дискретных сообщений. Любой сдвигающий регистр, состоящий из n триггеров, есть запоминающее устройство, способное принимать 2n различных состояний.
Если в регистр сдвига ввести обратные связи, каждая из которых формируется логической схемой, называемой схемой сложения по модулю два (или «ИСКЛЮЧАЮЩЕЕ ИЛИ»), то с помощью такого устройства можно построить генератор псевдослучайной последовательности или устройство деления одного многочлена на другой (кодирующие и декодирующие устройства).
Рассмотрим построение генератора псевдослучайной последовательности.
Случайной последовательностью называется последовательность из 1 и 0, в которой каждый элемент появляется в последовательности независимо от предыдущих символов. Случайные последовательности должны удовлетворять тестам на случайность:
· уравновешенности, когда число 1 и 0 в последовательности равно;
· корреляции, когда при почленном сравнении случайной последовательности с любым ее циклическим сдвигом число совпадающих символов равно числу несовпадающих символов;
· вероятность появления каждого набора из m элементов для m<n (где n – длина последовательности) равна 2-m.
Случайная последовательность не имеет ни начала, ни конца. Получить ее можно, подбрасывая монетку и рассматривая, какая сторона монетки выпадет. Если выпал “орел”, то записывается единица, если “решка”, то записывается ноль. На практике такие последовательности получить нельзя. Поэтому используют ограниченные (конечные) последовательности, которые обладали бы некоторыми свойствами случайных последовательностей. Такие последовательности называются псевдослучайными последовательностями (ПСП).
Получить ПСП можно с помощью регистра сдвига с логическими обратными связями. На простейшей схеме такого регистра (рис. 43) на один вход сумматора по модулю два подается сигнал с k-го разряда регистра, а на второй вход – сигнал с n-го разряда. Если в первый разряд регистра записать единицу, а в остальные нули, то под воздействием тактовых импульсов эта единица будет продвигаться по регистру. Когда k-й разряд примет состояние единицы, то на выходе сумматора появится единица, которая поступит на вход первого разряда и запишется в него. С этого момента в регистре сдвига будут продвигаться две единицы. Всякий раз, когда на входы сумматора по модулю два будут подаваться различные символы, в первый разряд регистра сдвига будет записана единица.

[image: Лаб3ПСПобщсх]

Рис. 43. Генератор псевдослучайной последовательности

Таким образом, под воздействием каждого тактового импульса разряды регистра сдвига принимают определенные состояния, причем последовательность этих состояний зависит от способа включения обратной связи. Общее число таких различных состояний равно 2n-1, следовательно, период ПСП равен 2n-1. ПСП можно снимать с выхода любого разряда регистра, в частности с последнего. Любая выходная последовательность, имеющая такой период, называется линейной последовательностью максимальной длины. 
Регистр с логической обратной  связью описывается характеристическим многочленом вида
F(x)= xn+ An-1xn-1 +…+ A2x2 + A1x+1.
Степень многочлена равна числу разрядов регистра, а коэффициенты Ai равны единице, если выход данного разряда подается на вход сумматора  по модулю два. 
В зависимости от количества и места подключения элементов обратной связи можно получить последовательность максимальной или меньшей длины. Для того чтобы последовательность имела максимальную длину, характеристический многочлен должен быть неприводимым, т.е. не разлагаться на произведение многочленов степеней, меньших n (или делиться только на единицу и на самого себя).
Таким образом, чтобы построить генератор ПСП, нужно знать неприводимый многочлен степени n. Если для данного n известен неприводимый многочлен, то число элементов 
обратной связи (сумматоров по модулю два) равно числу 
ненулевых слагаемых многочлена минус два; а номера разрядов регистра, выходы которых подаются на входы сумматоров по модулю два, определяются из сопряженных многочленов.
Сопряженные многочлены вычисляют следующим образом:
· в характеристическом многочлене производят замену переменных x=y-1:
1/yn+An-1/yn-1+…+A2/y2+A1/y+1;
· вновь полученный многочлен умножают на yn:
(yn /yn)yn + An-1(yn /yn-1) +…+ A2(yn /y2) + A1(yn /y) + yn=
=1+ An-1y +…+ A2yn-2+ A1y + yn.
Показатели степени переменной y сопряженного многочлена, у которых коэффициенты Ai не равны нулю, соответствуют номерам разрядов регистра, выходы которых подаются на сумматор по модулю два.
Для некоторых n неприводимые многочлены вычислены и сведены в таблицы. Некоторые из этих многочленов приведены в табл. 10.
Т а б л и ц а  10
	Число
разрядов n
	Многочлен
	Максимальная
длина ПСП
	Номера разрядов, выходы которых подаются на сумматор по модулю 2

	2
	x2+x+1
	3
	1, 2

	3
	x3+x+1
x3+x2+1
	7
7
	2, 3
1, 3

	4
	x4+x+1
x4+x3+1
	15
15
	3, 4
1, 4

	5
	x5+x2+1
x5+x3+1
	31
31
	3, 5
2, 5

	6
	x6+x+1
x6+x5+1
	63
63
	5, 6
1, 6

	7
	x7+x+1
x7+x6+1
	127
127
	6, 7
1, 7

	8
	x8+x4+x3+x2+1
x8+x6+x5+x4+1
	255
255
	4, 5, 6, 8
2, 3, 4, 8



Рассмотрим построение генератора ПСП при n=4. В таблице найдем характеристический многочлен степени 4 – g(x)=x4+x+1.
Заменим переменную и найдем сопряженный многочлен:
1/y4+1/y+1,    y4(1/y4+1/y+1)=1+y3+y4.
Следовательно, регистр сдвига имеет четыре разряда. Число сумматоров по модулю два, включаемых в обратную связь, равно 3-2=1. Номера разрядов, выходы которых подаются на входы сумматора по модулю два, равны 3 и 4. Схема генератора ПСП приведена на рис. 44.

[image: Лаб3ПСП1]
Рис. 44. Генератор ПСП для n=4

Если записать в первый разряд единицу, то под воздействием тактовых импульсов содержимое регистра будет меняться как в табл. 11.
Т а б л и ц а  11
	Номер такта
	Q1
	Q2
	Q3
	Q4

	1
	1
	0
	0
	0

	2
	0
	1
	0
	0

	3
	0
	0
	1
	0

	4
	1
	0
	0
	1

	5
	1
	1
	0
	0

	6
	0
	1
	1
	0

	7
	1
	0
	1
	1

	8
	0
	1
	0
	1

	9
	1
	0
	1
	0

	10
	1
	1
	0
	1

	11
	1
	1
	1
	0

	12
	1
	1
	1
	1

	13
	0
	1
	1
	1

	14
	0
	0
	1
	1

	15
	0
	0
	0
	1

	16
	1
	0
	0
	0



Начиная с 16-го такта последовательность состояний регистра повторяется. ПСП можно снимать с выхода любого разряда регистра, а также с выхода схемы сложения по модулю два. Псевдослучайная последовательность, генерируемая данным устройством, имеет вид  000100110101111.
В данном случае эта последовательность получена с выхода четвертого разряда регистра сдвига (пятый столбец табл. 11).
Инструкция по выполнению лабораторной работы
1.Исследование генератора ПСП для  n=4
1. Нарисовать схему генератора ПСП для n=4 (рис. 45). Поместить на схему функциональный генератор (Function Generator) и осциллограф (Oscilloscope).
На этой схеме логический элемент «4И-НЕ» введен для автоматической записи единицы в первый разряд регистра, если в момент включения питания все триггеры регистра сдвига установятся в состояние ноль. 
2. Открыть окно функционального генератора и установить частоту (1 кГц) и вид генерируемого сигнала (прямоугольные импульсы).

[image: Лаб3ПСП1]

Рис. 45 . Четырехразрядный генератор ПСП
3. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]   на панели инструментов, и в появившемся меню выбрать команду Run.
4. Щелкнуть по иконке осциллографа, чтобы открыть окно осциллографа, и зарисовать осциллограмму.
Описание осциллографа (Oscilloscope)
Работа осциллографа основывается на применении электронно-лучевой трубки (ЭЛТ), содержащей катод, излучающий поток (луч) электронов за счет термоэмиссии, модулятор для управления интенсивностью этого потока, систему его фокусировки, отклоняющую систему в виде двух пар пластин, и экран из кристалликов люминофора, которые под действием падающего на них потока электронов высвечивают траекторию движения электронного луча в пространстве, определяемую потенциалами на пластинах отклоняющей системы. Горизонтальные пластины этой системы называются Y-каналом, вертикальные – 
X-каналом.
На пластины Y-канала подается исследуемый сигнал после его усиления и масштабирования вертикальным Y-усилителем. Для одновременного наблюдения n сигналов используют n усилителей, выходные сигналы которых с помощью аналоговых коммутаторов поочередно подаются на вход усилителя мощности Y-канала.
На пластины X-канала подается пилообразный сигнал развертки, длительность (период) которого с помощью системы синхронизации поддерживается равным или кратным периоду исследуемого сигнала в одном из Y-каналов, что позволяет получить устойчивое, а не хаотично «бегающее» изображение контролируемого сигнала.
Осциллограф (рис. 46) имеет два канала (Channel) A и B с раздельной установкой чувствительности в диапазоне от 10 мкВ/дел (µV/Div) до 5 кВ/дел (kV/Div) и регулировкой смещения по вертикали (Y POS).

[image: Осциллограф]
Рис. 46. Лицевая панель осциллографа
На панелях Channel A и Channel B с помощью кнопок выбирается режим по входу. Режим АС предназначен для наблюдения только сигналов переменного тока. В режиме «0» входной зажим замыкается на землю. В режиме DC (включен по умолчанию) можно наблюдать сигналы как постоянного, так и переменного тока. С правой стороны от кнопки DC расположен входной  зажим канала. 
На этих панелях в окне Scale устанавливается величина развертки, а в окне Y position – величина смещения относительнооси Х.
На панели Timebase с помощью кнопок Y/T, Add, B/A, A/B выбирается режим развертки. В режиме Y/T (обычный режим, включен по умолчанию) устанавливается следующий режим развертки: по вертикали – напряжение сигнала, по горизонтали – время; в режиме Add – сигналы обоих каналов накладываются друг на друга; в режиме B/A: по вертикали – сигнал канала В, по горизонтали – сигнал канала А; в режиме А/В: по вертикали – сигнал канала А, по горизонтали – сигнал канала В.
В режиме Y/T длительность развертки (Timebase) может быть задана в диапазоне от 0,1 нс/дел (ns/div) до 1 с/дел (s/div) с возможностью установки смещения в тех же единицах по горизонтали, т.е. по оси Х (X POS).
В режиме Y/T можно установить ждущий режим в поле Trigger. В строке Edge – режим запуска по переднему (кнопка [image: Осцил1])  или  по заднему (кнопка [image: Осцил2]) фронту запускающего сигнала. В окне Lever (уровень) устанавливается уровень запускающего сигнала.
В этом поле с помощью кнопок Auto, А, В или Ext ждущий режим запускается от каналов А или В, от канала А, от канала В или от внешнего источника, подключаемого к находящемуся на этой панели зажиму,  соответственно.
С помощью кнопки Revere можно инвертировать изображение, кнопки Save можно записать данные в файл.
С помощью визирных линеек (синего и красного цвета) можно просканировать изображение. Результаты измерения напряжения, временных интервалов и их приращений (между визирными линейками) отображаются в индикаторных окошках, расположенных под экраном.  

2.Исследование генератора ПСП для  n=5 и g(x)=x5+x3+1
1. Нарисовать схему генератора ПСП для n=5 и 
g (x) = x5 + x3 + 1.
2. Запустить процесс моделирования, нажав кнопку [image: КнПуск] на панели инструментов, и в появившемся меню выбрать команду Run.
3. Щелкнуть по иконке осциллографа, чтобы открыть окно осциллографа,  и зарисовать осциллограмму.
3.Исследование генератора ПСП для  n=5 и g(x)=x5+x4+1
1. Нарисовать схему генератора ПСП для n=5 и 
g (x) = x5 + x4 + 1.
2. Запустить процесс моделирования, нажав кнопку  [image: КнПуск]   на панели инструментов, и в появившемся меню выбрать команду Run.
3. Щелкнуть по иконке осциллографа, чтобы открыть окно осциллографа, и зарисовать осциллограмму.

Контрольные вопросы:
1 Случайные последовательности должны удовлетворять каким тестам?
2 Какие функции выполняет регистра сдвига?
3 Описать назначение осциллографа?





















[bookmark: _Toc132447607]Лабораторная работа № 8
«Исследование арифметического сумматора»
Цель работы: научиться исследовать арифметический сумматор, полусумматор и полный сумматор.

Образовательные результаты, заявленные во ФГОС третьего поколения:
Студент должен 
уметь: 
 - Строить и использовать таблицы истинности логических функций, элементов устройств;
знать: 
-  Типовые узлы и устройства ЭВМ, взаимодействие аппаратного и программного обеспечения ЭВМ

Краткие теоретические и учебно-методические материалы по теме лабораторной работы
Арифметические сумматоры – составная часть арифметико-логических устройств (АЛУ) микропроцессоров (МП). Арифметический сумматор состоит из двух устройств: полусумматора и n полных сумматоров. Полный сумматор имеет три входа: A, B – входы суммируемых операндов, Ci – вход переноса из предыдущего разряда сумматора и два выхода: S – выход полного сумматора и C0 – выход переноса. Полусумматор отличается от полного тем, что у него нет входа переноса из предыдущего разряда. Полусумматор используется в качестве первого разряда арифметического сумматора, а в качестве остальных разрядов – полные сумматоры (рис. 47). Полусумматор – одна из простейших комбинационных логических схем. 
[image: АЛУ]
Рис. 47 . Четырехразрядный арифметический сумматор

Рассматривая таблицу истинности полусумматора (табл. 12) можно заметить, что выход S полусумматора  выполняет функции элемента  «ИСКЛЮЧАЮЩЕЕ ИЛИ», а выход переноса С полусумматора – элемента «И». Таким образом, логические выражения для функций S и C равны:
S=AB′+A′B,     C=AB.
Т а б л и ц а  12
	Входы
	Выходы

	А
	В
	S
	C

	0
	0
	0
	0

	0
	1
	1
	0 

	1
	0
	1
	0 

	1
	1
	0
	1



Схема полусумматора представлена на рис. 48.
[image: ПолуСум1]
Рис. 48. Структура полусумматора

Из таблицы истинности полного сумматора (табл. 13) можно получить логические выражения для S (суммы) и C (переноса в следующий разряд). Логическое выражение для S будет иметь четыре слагаемых, соответствующих строкам таблицы, в которых выход S равен единице (стоки 4, 5, 7, 10),
S= A′B′Ci-1+A′BCi-1′+AB′Ci-1′+ABCi-1.
Т а б л и ц а  13
	Входы
	Выходы

	А
	В
	Ci-1
	S
	Ci

	0
	0
	0
	0
	0

	0
	0
	1
	1
	0 

	0
	1 
	0
	1
	0 

	0
	1
	1
	0
	1

	1
	0
	0
	1
	0

	1
	0
	1
	0
	1

	1
	1
	0
	0
	1

	1
	1
	1
	1
	1



Логическое выражение для C также будет иметь четыре слагаемых (строки 6, 8, 9, 10):
Ci=A′BCi-1+A′BCi-1′+ABCi-1′+ABCi-1.
С помощью законов булевой алгебры (см. лаб. раб. №1) это выражение можно упростить, тогда оно будет иметь вид
Сi=ACi-1+BCi-1+AB.
Схема полного сумматора изображена на рис. 49.

[image: Полный Сум]
Рис. 49.  Структура полного сумматора

Инструкция по выполнению лабораторной работы
1. Собрать (нарисовать) схему четырехразрядного арифметического сумматора (рис. 50). Поместить на схему три16-ричных индикатора и генератор слова.
2. Открыть генератор слова и задать суммируемые числа. Четыре младших разряда каждого генерируемого слова составляют  первое слагаемое (операнд). Следующие четыре разряда составляют второе слагаемое (операнд).
3. Запустить процесс моделирования и следить за показаниями индикаторов. Записать суммируемые числа и результат суммирования.
[image: Лаб4АЛУ]
Рис. 50 . Схема исследования четырехразрядного сумматора

4. Собрать схему, изображенную на рис. 51, и с помощью логического анализатора, последовательно нажимая кнопки Circuit to Truth Table (таблица истинности цепи)  [image: ЛогПреобр1], Truth Table to Boolean Expression (булево выражение по таблице истинности)  [image: ЛогПреобр2], Boolean Expression to Circuit (создание схемы по булеву выражению) [image: ЛогПреобр5], получить:
· таблицу истинности полусумматора, 
· логические выражения для выходов S и  C, 
· схемную реализацию логических выражений для выходов S  и  C.
[image: ИсслПолСум]
а	б
Рис. 51. Схема исследования полусумматора: a – выход S, б – выход C

5. Собрать схему, изображенную на рис. 52, и с помощью логического анализатора получить  таблицу истинности полного сумматора, логические выражения для выходов S и  C и схемную реализацию логических выражений (см. п. 4).
[image: ИсслПолноСум]
а	б
Рис. 52. Схема исследования полного сумматора: a – выход S, б – выход C

Описание используемых контрольно-измерительных приборов

[bookmark: _Toc132447608]Генератор слова (Word Generator)  [image: ГенСлова1]

Генератор слова (или кодовый генератор) предназначен для генерации 32-разрядных двоичных слов, которые набираются пользователем в 16-ричном коде в строке Hex или  в двоичном коде в строке Binary на панели Edit  (рис. 53).
[image: ГенСлова]
Рис. 53. Лицевая панель генератора слова

В окне, расположенном слева на лицевой панели генератора слова, отображаются 8-разрядные 16-ричные числа от 00000000 до FFFFFFFF (от 0 до 4294967265). Каждая горизонтальная строка представляет 32-разрядное двоичное число. Эти числа поступают в параллельном виде на выходные клеммы генератора, расположенные в нижней части лицевой панели.
Чтобы изменить значение любого бита кодового слова, надо выбрать число (щелкнуть по нему, при этом оно меняет цвет), которое необходимо изменить, и ввести новое значение в строках HEX, ASCII или Binary на панели Edit. Измененное кодовое слово отображается на выходных клеммах генератора, расположенных в нижней части лицевой панели.
На панели Address расположены четыре окна. Каждое кодовое слово из списка имеет адрес, выраженный 4-разрядным 16-ричным числом. 
В окне Edit отображается адрес выбранного в таблице слова, в окне Current – адрес выдаваемого кодового слова.
В окне Initial устанавливается адрес первого кодового слова множества слов, поступающих на выход генератора, в окне Final  – адрес последнего кодового слова множества слов, поступающих на выход генератора.
Для того чтобы создать множество кодовых слов, выдаваемых генератором слова, нужно ввести адрес первого и последнего слова в окно Initial и Final соответственно.
На панели Controls устанавливается режим выдачи кодовых слов.
Чтобы выдать  32-разрядное слово на выход прибора, надо щелкнуть по одной из кнопок Step, Burst or Cycle. Номер этого слова отобразится в окне Current на панели Address.
Если необходимо выдать только одно слово, следует щелкнуть по кнопке Step, если все кодовые слова множества, то щелкнуть по кнопке Burst.
Если щелкнуть по кнопке Cycle, то будут выдаваться все кодовые слова множества непрерывно циклически. Остановить выдачу слов можно, повторно щелкнув по кнопке Cycle.
Если нужно остановить и возобновить выдачу слов с определенного слова, нужно щелкнуть по кнопке Breakpoint.
Чтобы установить контрольную точку (Breakpoint), нужно выбрать в списке кодовое слово, на котором следует остановить вывод слов, и затем щелкнуть по кнопке Breakpoint. У этого слова появится метка в виде звездочки.
Чтобы удалить контрольную точку, нужно выбрать существующую контрольную точку, затем щелкнуть по кнопке Breakpoint.
Можно установить несколько контрольных точек. Контрольные точки могут использоваться как при непрерывной (Cycle), так и при однократной  (Burst) выдаче множества слов.
С помощью кнопки Pattern можно создавать новые или использовать ранее записанные множества кодовых слов.
На панели Triggering расположены четыре кнопки, с помощью которых можно установить источник запускающего сигнала (внутренний (Internal) или внешний (External)) и фазу запускающего сигнала (по переднему или заднему фронту).
На панели Frequency устанавливается тактовая частота генератора слова в герцах, кило- или мегагерцах. Кодовые слова поступают на выход генератора с каждым тактом генератора. Рядом расположена клемма, на которую выдается сигнал готовности выдавать данные.

Логический преобразователь (Logic Converter) [image: Логич анализ1]

На лицевой панели преобразователя (рис. 54) расположены клеммы-индикаторы входов A, B, C, …, H и клемма выхода Out, окно для отображения таблицы истинности исследуемой схемы, строка для отображения ее булева выражения и панель Conversions.
На панели Conversions расположены шесть кнопок, используемых для получения:
· [image: ЛогПреобр1] – таблицы истинности исследуемого устройства,
· [image: ЛогПреобр2] – булева выражения, реализуемого исследуемым устройством,  
· [image: ЛогПреобр3] – минимизированного булева выражения, 
[image: ЛогПреобр]
Рис. 54. Лицевая панель логического преобразователя

· [image: ЛогПреобр3] – таблицы истинности по булевому выражению;
· [image: ЛогПреобр5] – схемы устройства по логическому выражению на логических элементах без ограничения их типа,
· [image: ЛогПреобр6]– создания схемы устройства только на логических элементах «И-НЕ».

Контрольные вопросы 
1 Какие операции выполняют арифметические сумматоры?
2 Зарисовать схему полусумматора?
3 Что показывает лицевая панель генератора?
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